## Contents

List of Figures .................................................. 5

List of Tables .................................................. 6

1 Introduction .................................................... 8
   1.1 QuickStart ............................................... 8
      1.1.1 Other software .................................... 8
      1.1.2 FITS integration .................................... 8

2 Measurements .................................................. 10
   2.1 Getting accurate readings .............................. 11
      2.1.1 Seeing conditions ................................. 11
      2.1.2 Light pollution ................................... 11
      2.1.3 Other luminance scales ........................... 12

3 Theory of operation .......................................... 15
   3.1 Light measurement ...................................... 15
   3.2 Communication to the PC ............................... 15

4 Specifications ................................................ 16

5 Hardware connections ......................................... 18

6 Software development ......................................... 19
   6.1 Writing your own software interface .................. 19
   6.2 Pascal .................................................. 20

7 Unihedron Device Manager .................................... 21
   7.1 Getting UDM ............................................. 21
   7.2 Installation ............................................ 21
      7.2.1 System requirements ............................ 21
      7.2.2 Windows ........................................... 21
      7.2.3 Mac ............................................... 21
      7.2.4 Linux .............................................. 21
   7.3 Operation .............................................. 22
      7.3.1 Start up ........................................... 22
      7.3.2 Main screen ....................................... 22
      7.3.3 Main menu ......................................... 23
      7.3.4 File menu ......................................... 23
      7.3.5 Tools menu ....................................... 27
      7.3.6 Help menu ........................................ 30
   7.4 Information tab ......................................... 32
   7.5 Log Continuous ......................................... 33
   7.6 Calibration tab ......................................... 38
   7.7 Report Interval tab ..................................... 39
List of Figures

12.1 Recalibration .......................................................... 69
12.2 Light calibration ....................................................... 69
12.3 Dark calibration ....................................................... 69
12.4 Confirmation ........................................................... 69

13 Troubleshooting .......................................................... 70

14 Glossary ........................................................................ 74

15 Bibliography ..................................................................... 75

2.1 Mpsas interpretive scale .................................................. 10
2.2 Mpsas vs NELM ............................................................ 13
4.1 Front of unit ................................................................. 17
4.2 Back of unit ................................................................. 17
5.1 Wired connection ............................................................ 18
7.1 Splash screen ............................................................... 22
7.2 File menu ................................................................. 23
7.3 File Open dialog ........................................................... 24
7.4 View menu ................................................................. 24
7.5 View : Log ................................................................. 25
7.6 View:Directories .......................................................... 25
7.7 Data logging header ...................................................... 26
7.8 Set Location dialog ....................................................... 27
7.9 Tool : old log to dat ....................................................... 28
7.10 Tool : dat to Moon csv .................................................. 28
7.11 Tool : Comm terminal ................................................... 29
7.12 Tool : .dat to .kml ....................................................... 29
7.13 Tool : .dat time correction ............................................. 30
7.14 Tool : .dat local time reconstruction .............................. 30
7.15 Help menu ................................................................. 30
7.16 Help : About ............................................................. 31
7.17 Found device (single) .................................................... 31
7.18 Found device (multiple) .................................................. 31
7.19 USB connection details ................................................. 32
7.20 Ethernet connection details ............................................ 32
7.21 RS232 connection details ............................................. 32
7.22 Information tab .......................................................... 32
7.23 Log Continuously screen .............................................. 33
7.24 Log Continuously Trigger tab ....................................... 33
7.25 Log Continuously Threshold ......................................... 34
7.26 Log Continuously Pre-audio alert .................................. 34
7.27 Log Continuously Alarm for darkness ............................ 34
List of Tables

2.1 Apparent Magnitudes of Known Celestial Objects adapted from [2] ........................................ 10
7.2 simin.csv field description ................................................................. 44
7.3 Log continuous command line parameters ........................................... 46
7.4 Select device command line parameters .............................................. 46
7.5 Select device command line parameters .............................................. 46
8.1 Summary of standard commands ......................................................... 47
8.2 Reading request response ................................................................. 48
8.3 Unaveraged reading request response .................................................. 48
8.4 Unit information request response ....................................................... 49
8.5 Calibration information request response ............................................ 50
8.6 Light calibration response ................................................................. 50
8.7 Dark calibration response ................................................................. 51
8.8 Disarm calibration response .............................................................. 51
8.9 Response for manual setting of light calibration offset ......................... 52
8.10 Response for manually setting of light calibration temperature ............. 52
8.11 Response of manually setting dark calibration time period .................. 53
8.12 Response for manually setting of dark calibration temperature ............. 53
8.13 Humidity/temperature command summary ........................................ 55
8.14 Humidity/temperature response summary ......................................... 55
8.15 Display accessory command summary ............................................... 56
8.16 Display accessory response summary ............................................... 56
8.17 LED accessory command summary .................................................... 57
8.18 LED accessory response summary .................................................... 57
List of Equations

2.1 MPSAS to cd/m² ................................................. 12
2.2 NELM to MPSAS ............................................... 13
2.3 MPSAS to NELM ............................................... 13
8.1 Raw Temperature to degC .................................... 63
8.2 degC to Raw Temperature .................................. 63
1 Introduction

Thank you for purchasing the SQM-LU. You will soon be on your way to collecting scientific data.

The SQM series of products have been used in the following applications:

- Quantitatively comparing the sky brightness at different astronomical observing sites.
- Documenting the evolution of light pollution.
- Setting planetarium dome illumination to mimic the skies that people are likely to experience elsewhere in the city.
- Monitoring sky brightness through the night, night-to-night, and year-to-year for astronomical observation records.
- Determining which nights show the greatest promise for finding the 'faintest fuzzies'.
- Calibrating the effect of sky brightness on qualitative measures such as the Bortle Scale or NELM.
- Investigating how sky brightness correlates with the solar cycle and month-to-month sunspot activity.
- Helping to provide local ground truth for future sky brightness prediction with the Clear Sky Clock.
- Helping CCD users make a correlation between the SQM reading and when the background reaches some ADC level.
- Assisting Sea Turtle researchers in studying the amounts of light in areas where turtle hatchlings are affected by artificial lights.
- Researching bird-song synchronization with dawn.
- Researching twilight brightness changes with the addition of external Neutral Density filters. Unihedron offers adapters to attach such filters onto the meter.

1.1 QuickStart

1. Connect the SQM-LU meter to the computer with the supplied USB cable. Wait for any device drivers to automatically load (if required). You may have to visit www.FTDIchip.com to get the latest VCP drivers if they do not get installed automatically.

2. Ensure that your computer date and time is up-to-date.

3. Install and launch UDM (Unihedron Device Manager software supplied on the CD from your File Manager).

4. Click the “Find” button to find attached devices, then click on the SQM-LU that you connected.

5. Click on “Reading” to get a reading from the SQM-LU.

6. Logging and plotting can be done from the “Log Continuous” button.

1.1.1 Other software

- If you are using Windows, you may want to use Knightware SQM-Reader from www.knightware.biz/sqm.
- The CD contains examples of software (Perl, Python, etc.) for various functions that connect to the meter.

1.1.2 FITS integration

Some programs (listed below) gather information from the Unihedron Sky Quality meter products and insert that data into the Flexible Image Transport System (FITS) header.

- MaxPilote (Freeware) incorporates SQM readings from an SQM-LE/SQM-LU into the FITS header while at the same time provide constant readings in a live and updated Data Window.
- CCDAutoPilot
- FITS4Win2 uses the MPSAS keyword for sorting and filtering image files.
2 Measurements

The SQM-LU provides readings in Magnitudes per square arcsecond, abbreviated as: mpsas, and written mathematically as \( \text{mag arcsec}^2 \).

Mpsas is a logarithmic measurement which means that large changes in sky brightness correspond to relatively small numerical changes. A difference of 5 magnitudes is a factor of 100 times the intensity. Therefore a sky brightness \( 5.0 \text{mag arcsec}^2 \) darker corresponds to a reduction in photon arrival rate of a factor of 100.

The following schematic gives a rough idea of how to interpret the readings of the SQM:

![Figure 2.1: Mpsas interpretive scale](image)

**Magnitudes** are an astronomical unit of measure for object brightness. Brighter objects have a lower magnitude and darker objects have a higher magnitude value. For example; a star that is 6th magnitude is brighter than a star that is 11th magnitude.

The star Vega is used as the reference point of \( \approx 0 \) magnitude. Table 2.1 shows the apparent magnitude of some common known celestial objects.

<table>
<thead>
<tr>
<th>App. Mag.</th>
<th>Celestial Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>−26.73</td>
<td>Sun</td>
</tr>
<tr>
<td>−12.6</td>
<td>full Moon</td>
</tr>
<tr>
<td>−4.7</td>
<td>Maximum brightness of Venus</td>
</tr>
<tr>
<td>+0.03</td>
<td>Vega, the original zero point</td>
</tr>
<tr>
<td>+6</td>
<td>Faintest stars observable with naked eye</td>
</tr>
<tr>
<td>+27</td>
<td>Faintest objects observable in visible light with 8m ground-based telescopes</td>
</tr>
<tr>
<td>+30</td>
<td>Faintest objects observable in visible light with Hubble Space Telescope</td>
</tr>
</tbody>
</table>

**Arcsecond** is the definition of an arc being divided up into seconds as follows.

1. There are 360 degrees in a circle.
2. There are 60 arcminutes in a degree, and 21600 arcminutes in a circle.
3. There are 60 arcseconds in an arcminute, and 1296000 arcseconds in a circle.

Square arcsecond \((\text{arcsec}^2)\) is the area covered by a square measuring \(1\text{arcsec} \times 1\text{arcsec}\).

Magnitude per square arcsecond is the definition of brightness in magnitudes spread out over one square arcsecond of the sky. For example; if the SQM provides a reading of 20.00 mpsas, that would be like saying that a light of a \(20^{\text{th}}\) magnitude star brightness was spread over one square arcsecond of the sky.

The "magnitudes per square arcsecond" numbers are commonly used in astronomy to measure sky brightness. More details can be found at www.stjarnhimlen.se/comp/radfaq.html

Each magnitude lower (numerically) means just over 2.5 times as much more light is coming from a given patch of sky. A change of 5 mags/sq arcsec means the sky is 100x brighter.

The darkest we've personally experienced with the SQM in a natural clear sky was 21.80.

2.1 Getting accurate readings

Various factors will cause the night sky brightness to fluctuate. Taking more readings will be useful in ruling out spurious events. The SQM gathers light for at least a one second period, and the brightness report is based on the light that was accumulated during that time.

At the darkest sites, natural variations in conditions such as airglow and the brightness of the zodiacal light are limiting factors.

**Prevent artificially high (dark) readings** by ensuring that there is nothing blocking the view of the sensor. Avoid taking readings near trees or buildings that may block the sensor. A reading of greater than 22.0 is unlikely to be recorded, however there are reasons for extra dark readings:

- Cloud or ash covered sky in a remote area where little natural sky brightness can be recorded.
- Uncorrected readings from covered meter like a weatherproof housing.
- Obstructed view like inside a forest, or where large buildings are located within the field of view, or a person or bird blocking the view.

When the sky is very dark, the meter takes longer to gather enough light to produce a reading. During this time of light gathering, the reading will remain constant until the meter can start gathering readings fast enough for new reading-requests.

The readings are averaged in an 8-cell rolling buffer, so it may take a while for the meter to produce a new value of darkness when obstructions leave the field of view.

**Prevent artificially low (bright) readings** by ensuring that there are no lighted objects (street lamps, the moon, etc.) that shine into the sensor at any angle.

2.1.1 Seeing conditions

Scintillation is due to refractive changes in the atmosphere caused by temperature changes at differing heights.

Stars are too small in comparison to the entire SQM field of view, so scintillation is not expected to alter the SQM reading significantly.

2.1.2 Light pollution

Undesirable artificial light that reaches you is considered to be light pollution. Much of this light comes from outdoor illumination of parking lots, street lamps, office buildings, advertising signs, etc.

Other causes of extra light in the night sky are listed below:
2 Measurements

**Aurora**

Charged particles emitted from the Sun are directed to the poles of the earth by the Earth’s magnetic field. These particles collide with atoms in the atmosphere and cause light to be emitted. Aiming the meter at the polar regions during Aurora Borealis (in the North) or Aurora Australis (in the South) will reduce the reading (lighter). Aiming the meter towards the equator will increase the reading (darker) under these conditions.

**Airglow**

Airglow is light produced by various phenomenon in the atmosphere which prevent the sky from being totally dark. Effects of the magnetic poles of the Earth may cause airglow to be brighter near the poles.

**The Milky Way**

As one goes to sites with darker surface brightnesses, the fraction of the total light received by the SQM-LU which can be attributed to the Milky Way bulge increases and so the “offset” in mpsas will be larger (due to the Milky Way.)

The northern view of the Milky Way contributes about 0.10 mpsas under 21.5 mpsas (moonless) skies.

The southern view of the Milky Way might be as big an effect as 0.56 mpsas in dark skies where it goes near-overhead.

For more information, see Surface Photometries of the Milky Way (Schlosser+ 1997)

vizier.u-strasbg.fr/ftp/cats/VII/199/ReadMe

**Moisture**

Clouds, fog, and mist will reflect artificial light back down to the Earth causing a brighter (lower) reading. If there is no artificial light, then clouds may prevent starlight from coming to you and the reading will be darker (higher). This extra-dark situation can occur in very isolated areas like mountain tops, the ocean, or the desert. You will have to be aware of this special situation when analyzing readings.

**Volcanic eruptions**

Dust released into the atmosphere by volcanoes can reflect light from the surface of the earth back down. In a dark location this dust will prevent the light from stars and Milky Way and produce a darker (higher) reading.

**Zodiacal light**

The sunlight reflected of off dust particles in the ecliptic plane of our solar system is called zodiacal light.

The amount of light will be different depending on whether the meter is pointed to the poles or plane of the solar system. It is likely to have less than 2% effect. The primary reason for this small effect is that the brightest and widest part of the zodiacal light is nearest the horizon where the SQM has almost no sensitivity (due to it being a primarily zenith-looking device). The portions at higher altitude are the narrowest and faintest and they would barely creep into the sensitivity cone of the SQM.

2.1.3 Other luminance scales

**Candela per square meter** \((\text{cd/m}^2)\) is commonly used by lighting engineers.

To convert the SQM mpsas reading to \(\text{cd/m}^2\), use Equation (2.1):

\[
[\text{cd/m}^2] = 10.8 \times 10^4 \times 10^{(-0.4 \times \text{mag/arcsec}^2)}
\]  

**Naked eye limiting magnitude** \((\text{NELM})\)

Quite often astronomers will refer to a sky by the darkest star they can see, for example a “6th magnitude sky”, in that case you can see 6th magnitude stars and nothing dimmer like 7th magnitude stars. The term “6th magnitude skies” is very subjective to a persons ability to see in the night, for example an older person might say “5th magnitude skies” but a young child with better night vision might say “7th magnitude skies”.

Nobody has performed the task of defining a relationship between the two methods of sky brightness (x magnitude skies and magnitudes per square arcsecond) -- probably because one is subjective and the other is objective and a wide variety of people would have to be polled.

An approximation exists for the conversion between NELM and MPSAS. You can use an NELM converter created by SQM user K. Fisher to do that conversion, or the chart shown in Figure 2.2 and Equations (2.2) and (2.3).

\[ B_{\text{mpsas}} = 21.58 - 5 \times \log(10^{0.316 - (B_{\text{mpsas}}/5)}) + 1 \]  \hspace{1cm} (2.2)

\[ N_{\text{ELM}} = 7.93 - 5 \times \log(10^{4.316 - (N_{\text{ELM}}/5)}) + 1 \]  \hspace{1cm} (2.3)

**Figure 2.2: Mpsas vs NELM**

Convert NELM (V mags) to MPSAS (B) sky brightness [3]

\[ B_{\text{mpsas}} = 21.58 - 5 \times \log(10^{0.316 - (N_{\text{ELM}}/5)}) + 1 \]  \hspace{1cm} (2.2)

Convert MPSAS (B) sky brightness to NELM (V mags) [4]

\[ N_{\text{ELM}} = 7.93 - 5 \times \log(10^{4.316 - (B_{\text{mpsas}}/5)}) + 1 \]  \hspace{1cm} (2.3)

**NSU**

A newly proposed term to define “Natural Sky Units”: 
In “natural sky units” (radiance relative to an assumed natural radiance of 21.6 mag/SQM/arcsec\(^2\), see methods), the range was 0.22 - 2200 NSU. Before the introduction of anthropogenic light, the radiance of a patch of sky near zenith on moon-free nights is likely to have been nearly always within the range 21 (galactic center near zenith) to 24 mag/arcsec\(^2\) (very thick clouds), or 0.1 - 1.7 NSU.[1]
3 Theory of operation

3.1 Light measurement

The SQM-LU measures the darkness of the night sky to provide readings of magnitudes per square arc second through the USB connection.

A light to frequency sensor (TSL237) provides the micro-controller with a signal whose frequency depends on the amount of incoming light. And, readings from the temperature sensor are used to compensate the light sensor readings through the range of operating temperatures.

In bright skies, the sensor produces a high frequency square wave (up to 500kHz). As the sky gets dark, the sensor produces a low frequency. In absolute darkness, the sensor period is very long, and is defined on the calibration sheet as “Dark period” with a 300s timeout.

Measurement of this wide range of frequencies is done by timers and counters inside the microprocessor. It is difficult for a microprocessor to accurately measure the period of high frequency signals, and just as difficult to measure the frequency of extremely low frequency signals. For this reason the microprocessor has two modes of signal measuring:

- **Frequency mode**: The frequency mode is for bright readings where the frequency is high. The sensor signal is fed into a counter that is gated at one second intervals to report a frequency measured in Hz.

- **Period mode**: The period mode is for dark readings where the frequency is low. The sensor signal gates a high speed internal counter which reports the period measured in µs.

Both Frequency and Period results are available when connected directly to the meter and using the “rx” command.

The SQM-LU computes mpsas by deciding if the period or frequency report should be used and then compensating for temperature. Deciding between period or frequency mode reporting was originally done at a frequency of 354Hz, but by selecting the “Ideal crossover firmware” setting on the “Report interval” page, the switchover will be 679Hz which offers the best resolution at the switchover point.

The SQM-LU holds the updated period and frequency recordings in memory while waiting for an asynchronous user request for a reading. It is possible for the user to see stale readings if the light sensor cannot gather enough light to produce a reading before the user asks for the next report (i.e. using the “rx” command too frequently). Starting at firmware version 58, the SQM-LU can provide a status of the reading that the user has requested by using the “r1x” command which contains a status suffix character of F/P/S whose meaning is:

- **F**: fresh FREQUENCY mode reading.
- **P**: fresh PERIOD mode reading.
- **S**: STALE reading indicates that this reading has not changed since the last reading because there was not enough light gathered to produce a new reading.

3.2 Communication to the PC

Commands sent from a PC through the USB cable to the USB interface are relayed to the micro-controller.

The micro-controller responds to commands by sending data strings to the USB interface which are then relayed to the PC.

Readings are gathered asynchronously by the micro-controller. Requests from the PC are buffered and dealt with as time permits.
### 4 Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USB connection</strong></td>
<td>USB B connector. 5m USB A to USB B cable supplied. USB FTDI VCP driver, serial port emulator at 115200baud.</td>
</tr>
<tr>
<td><strong>Physical Size</strong></td>
<td>3.6” x 2.6” x 1.1”</td>
</tr>
<tr>
<td><strong>Meter weight</strong></td>
<td>80g</td>
</tr>
<tr>
<td><strong>Meter precision</strong></td>
<td>Each SQM-LU is factory-calibrated. The absolute precision of each meter is ±10% (±0.10 mag/arcsec²). The difference in zero-point between each calibrated meter is typically ±10% (±0.10 mag/arcsec²)</td>
</tr>
<tr>
<td><strong>Field of View</strong></td>
<td>The Half Width Half Maximum (HWHM) of the angular sensitivity is ≈ 10°. The Full Width Half Maximum (FWHM) is then ≈ 20°. The sensitivity to a point source ≈ 19° off-axis is a factor of 10 lower than on-axis. A point source ≈ 20° and ≈ 40° off-axis would register 3.0 and 5.0 magnitudes fainter, respectively.</td>
</tr>
<tr>
<td><strong>Power requirement</strong></td>
<td>18mA (from the 5V USB connection).</td>
</tr>
<tr>
<td><strong>Operating temperature range</strong></td>
<td>-40°C to 85°C</td>
</tr>
<tr>
<td><strong>Temperature Accuracy</strong></td>
<td>± 2°C maximum at 25°C</td>
</tr>
<tr>
<td><strong>Temperature update rate</strong></td>
<td>4.3 seconds, 256 samples taken at 60Hz then averaged.</td>
</tr>
</tbody>
</table>
Figure 4.1: Front of unit

Figure 4.2: Back of unit
5 Hardware connections

The SQM-LU requires one connection to a USB hub or a PC for configuring the device and recovering the readings as shown in Figure 5.1.

The maximum length cable per the USB specification is 15ft (3m). USB extenders exist on the market, some work up to 198ft (60m).
6 Software development

The SQM-LU uses the FTDI FT232R chip to communicate as a standard serial port device at 115200 baud using the FTDI software drivers which are available for all major operating system platforms. Drivers are available from www.ftdichip.com.

Once the driver is installed, commands can be sent to the SQM-LU using a serial terminal emulator to the serial communications port that the device routes to.

When connecting the SQM-LU to a PC where the FTDI device driver is loaded, the serial port label will be determined at connection time.

Each SQM-LU has a unique serial number usually with a prefix of “FT........”. This serial number can be used to identify the exact SQM-LU device from other USB devices.

6.1 Writing your own software interface

All of the commands and responses of the SQM-LU are documented in Section 8.

To communicate with the SQM-LU, the following general steps are required:

1. A serial 115200 baud connection must be made to the serial port assigned to the SQM-LU.
2. Data commands are sent to the SQM-LU, and it responds with a string of characters.
3. Close the serial port so that other programs can access the SQM-LU. Note: Only one connection can be made to the SQM-LU at a time. Therefore leaving a connection open constantly prevents other connections from being made.

Various examples of reading from the SQM devices are supplied on the CD and available at the Unihedron website. Below is an example using Perl to read the SQM USB device:

Listing 6.1: Read SQM-LU using Perl

```perl
#!/usr/bin/perl

#Filename: read-sqmlu.pl
#Description: Utility to read Unihedron Sky Quality Meter-LU (USB model)

# Define the required module
use Device::SerialPort;

# Open and configure serial port
$port= Device::SerialPort->new("/dev/ttyUSB2");
$port->user_msg(ON);
$port->baudrate(115200);
$port->parity("none");
$port->stopbits(1);
$port->databits(8);
$port->handshake("none");
$port->write_settings || undef $port;
$port->read_char_time(1); # Wait for each character

# Send request to SQM
$port->write("rx\r");

# Get response from SQM
($count,$saw)=$port->read(255);

# Close the port so that other programs can use the SQM
$port->close;
```
The above program prints a result like this:

```
r,-09.42m,00000005915Hz,0000000000c,0000000.000s, 027.0C
```

## 6.2 Pascal

The UDM program contains many examples of finding the SQM devices and reading data from them. It is open source and written in Lazarus/FreePascal. The source files for UDM are available here:

unihedron.com/projects/darksky/cd/udm/.
7 Unihedron Device Manager

The Unihedron Device Manager (UDM) program is intended for use in maintaining and testing the Unihedron connected Sky Quality Meter products. Windows, Mac, Linux versions of UDM are available on the supplied CD. It is used to:

- Read version information.
- Request readings.
- Read and set calibration data.
- Read and set all other meter parameters.
- Install new firmware.
- Setup and retrieve data from datalogging meters.
- Continuously log data from connected meters.

7.1 Getting UDM

UDM is supplied on the CD that shipped with the SQM-LU. The latest version of UDM is available at the Unihedron website at this location

www.unihedron.com/projects/darksky/cd/

7.2 Installation

7.2.1 System requirements

The UDM is a fairly simple (but large) program which should run sufficiently on any present-day computer under the Windows, Mac, or Linux operating systems.

The Windows version of UDM can also be run in a virtualization mode using VMware Fusion. Access to the network is achieved by the menu Virtual Machine > Network Adapter > Bridged (Autodetect) being checked.

7.2.2 Windows

The Windows version of UDM is in a setup.exe style file located in the Windows subdirectory of the CD, for example:

\Windows\setup1.0.0.38.exe

Simply double-click on that file to start the installation procedure.

7.2.3 Mac

The Mac OSX version of UDM is a dmg file located in the Mac subdirectory of the CD, for example:

/Mac/udm.app.dmg

Drag the app to the /Applications directory.

7.2.4 Linux

The Linux version of UDM is available in a Debian package separately for both 32bit and 64bit systems located in the Linux directory of the CD, for example:

/Linux/udm_20140821-1_i386.deb

Open the file with package installer program like GDebi.
7.3 Operation

After starting UDM, a list of found devices should appear, if your device is not listed on the screen, try clicking “Find” once more to search for connected devices.

If more than one SQM device is found, then you will have to select (click) on one of the devices, otherwise if only one device is found, then click on “Version” or “Reading” of the information tab for more information.

The tabs can be used to select various functions when working with your selected device. These tabs and their functions are described further in this document.

7.3.1 Start up

After starting the UDM program, a splash screen shown in Figure 7.1 is temporarily shown while the program searches for attached devices.

![Unihedron Device Manager](image)

Figure 7.1: Splash screen

1. UDM searches for attached USB devices first. This step is fairly quick (a few seconds).
2. UDM then searches for attached Ethernet devices within the reach of the Ethernet network but not outside a firewall. This step may take about 30 seconds.

If no devices are found, then the main UDM program will be shown with the “found devices box” empty. You can attach an SQM device to your computer and press the “Find” button to search for the newly connected devices.

If you know that an Ethernet device is connected but it does not show up, then a network problem may be the cause. Also check the power connection to the SQM-LE.

If you know that a USB device is connected but it does not show up, then there may be a device driver issue. Check the USB device listing for your operating system. These USB devices should appear as a COMM port. Also, check the troubleshooting notes in section 13 on page 70 for possible solutions.

7.3.2 Main screen

The main screen of UDM consist of the following sections:
7.3 Operation

1. Window controls
2. Menu
3. Found devices box
4. Selected device details
5. Information section
6. Status bar

7.3.3 Main menu

The main menu of UDM consists of the items; File, View, Tools, Help as defined below.

7.3.4 File menu

The file menu is used for: opening files, finding newly attached devices, and quitting the program as shown in Figure 7.2.

![Figure 7.2: File menu](image)

**File : Open**

The “File : Open” menu item is used to open up previously stored log files or calibration reports.
The “File : Find USB” function can be used to only find attached USB devices and ignore possible Ethernet devices. The hotkey Ctrl+U can also be used instead of the mouse.

File : Find Ethernet

The “File : Find Ethernet” function can be used to only find attached Ethernet devices and ignore possible USB devices. The hotkey Ctrl+E can also be used instead of the mouse.

File : Quit

The “File : Quit” menu item is used to close the UDM program. The program can also be closed from the window panel “X”.

View menu

The view menu allows you to enable various tabs and check other settings of the UDM program.

View : Simulation

Click on “View : Simulation” to toggle visibility of the “Simulation” tab. The Simulation tab can be used to send requests to the SQM-LU to simulate conversions of frequency and period to light meter values. See page 43 for more details.
**View : Configuration**

Click on “View : Configuration” to toggle visibility of the “Configuration” tab. The Configuration tab is used to configure the SQM with its calibration values when calibrated light and dark settings are being performed.

**View : Log** shows a window of commands and responses sent to and received from the SQM during this session of running UDM. Some excessively repetitive commands are suppressed from this listing.

![Figure 7.5: View : Log](image)

**View : Directories** shows the directory paths used by UDM to store and retrieve data.

![Figure 7.6: View:Directories](image)

**Logs Directory Path** shows the path where logged records are kept. These logged records are created when using the “Log one Record” or “Log Continuously” features. Also, log files from data-logging meters will be stored here from the “Retrieve All” function.

The “Logs Directory Path” path can be changed from its default by pressing the folder button the right. After the path has been changed, new log files will be stored in that new folder.

**TZ database path** The Time Zone information is required for datalogging purposes because the timestamp is logged as UTC. Since time zones change over the years, the entire Time Zone database is required and hence distributed with UDM and stored at the displayed “TZ database path”. This path is not changeable.

The Time Zone database is taken from: [http://www.twinsun.com/tz/tz-link.htm](http://www.twinsun.com/tz/tz-link.htm)

**Firmware files path** The firmware for the SQM-LU can be updated or reverted using UDM. These firmware files are stored at the displayed firmware files path. This path is not changeable.
**Data Directory** is the place where some data files are kept, specifically the change-log for UDM and firmware files. This path is not changeable.

**Configfile path** is the place where UDM stores its configuration about the program and attached SQM devices. This path is not changeable.

**View : DL Header** shows the Data-logger header editing page. See the information at www.darksky.org/measurements for a detailed description of each field.

![Data logging header](Figure 7.7: Data logging header)

**DL : Position** can be changed by pressing the Edit button which calls up the following dialog:
7.3 Operation

The “Set location” dialog is used to type in your location and have it verified on the world map. Use the following steps to set the location:

1. Type the exact location coordinates (in degrees) of the SQM-LU into the “Desired” fields.
2. The mouse pointer can be used to select an approximate location if you are not sure of the exact coordinates.
3. The “Elevation” entry is optional as it is not used for anything yet.
4. Press the “Apply” button when you are satisfied with the desired values. Note: The “Apply” button will only be enabled if there is a difference between the desired and actual values.
5. Press “Close” when you are satisfied with the actual values.

The “Local timezone region” and “Local timezone name” are required by UDM to calculate local times of the recorded data before storing to disk. UTC timestamps are stored in the SQM-LU.

The cover offset is a text only field that indicates what offset was used on the calibration data of the SQM-LU.

7.3.5 Tools menu

Tools : old log to dat

The “old log to dat” tool is used to convert the original .log files that UDM created before the .dat file was made standard. Figure 7.9 shows the setup dialog for conversion.
The “dat to Moon csv” tool is used to convert .dat files to a csv file that contains Moon data using algorithm library from Andreas Hörstemeier [6].

The value for “Moon phase angle” reported in the .csv is:

- 180 or -180 = Full Moon
- 0 = New Moon
- Positive numbers Waxing (growing)
- Negative numbers Waning (shrinking)

Press the “Select ...” button shown in Figure 7.10 to select the file and start the conversion process.

The “Comm terminal” is a communication terminal window used for sending manual commands and viewing the response of the selected (from the found devices window) device.
7.3 Operation

**Tools**: DL retrieve

The “DL retrieve” tool is used for Vector model to pull in data files that were stored on disk previously.

**Tools**: .dat to .kml

Converts a .dat file to a .kml file. This is used when the SQM-LU and an external GPS are read by UDM in the Log Continuous datalogging mode. The .kml file can be imported into GoogleEarth to create an image similar to this:

![Figure 7.12: Tool : .dat to .kml](image)

This tool uses a legend image (mpsaslegend.png) which must be available to GoogleEarth to properly display the legend.

**Tools**: .dat time correction

Corrects a .dat file for out of synch timing by a manually entered offset. See figure 7.13.

This may be useful when the battery has expired in the datalogging meter, or if the clock was not set at the beginning of the datalogging session.
Select the .dat file for correction.
Enter the manual time offset correction (in seconds).
Press the “Correct .dat file” button to write the corrected file to disk. The location of the new file is shown in the bottom Filename section.

**Tools : .dat reconstruct local time**

If the datalogger timezone was not set properly, this tool can be used to recreate the local time values in the .dat file.

Select the desired .dat file to reconstruct.
Select the proper region and time zone.
Press the “Reconstruct .dat local times” button
The reconstructed file will be written to disk at the location specified in the bottom Filename section.

**Tools : .dat time correction**

### 7.3.6 Help menu

Select the desired .dat file.
7.3 Operation

**Help : Cmdline Info** shows the commands that can be used when starting UDM from the command line.

**Help : Version Info** shows the detailed version information for the UDM software.

**Help : About** displays a simple screen with the version identifier.

![Figure 7.16: Help : About](image)

**Found devices** box shows all the connected SQMs available that UDM can find from this computer.

If only one device is found, then UDM auto-selects it and gathers the version information for that selected device.

![Figure 7.17: Found device (single)](image)

If more than one device is found, then UDM does not select any of the devices. You may select the desired device by clicking in the found devices box on the SQM that you want to know more about. Once you select the device, then the connection details are displayed. Clicking on the “Version” or “Reading” button will gather more information from the meter.

![Figure 7.18: Found device (multiple)](image)

**Device details** shows the connection details of the selected SQM listed in the “Found devices” box.

The USB “Port” field is editable so you may enter your own port that might not be defined in the found box. See Figure 7.19.
The Ethernet IP and port fields are editable so you may enter your own IP and port that might not be defined in the found box. The default port number for the SQM-LE is 10001. See Figure 7.20.

The RS232 fields are editable so you may enter your own port and baud rate. The baud rate for the SQM-LR is 115200. See Figure 7.21.

### 7.4 Information tab

The information tab is used to show information about the version and the reading of the selected SQM. Press the “Version” button for an updated list of data about the device version, and press the “Reading button” for an updated list of data about the device reading.

The Header button calls up the data file header entry screen, see the datalogging Header section on page 26 for more information. This header information is used when storing logged data to the disk with the “Log one record” or “Log
The “Log continuous” function allows data from the connected SQM device to be logged repetitively as shown in Figure 7.23.

![Figure 7.23: Log Continuously screen](image)

**Log Continuous Trigger** options must be defined before logging, see Figure 7.24 for possibilities:

![Figure 7.24: Log Continuously Trigger tab](image)

To operate the continuous logging function:

1. Select the frequency of logging from the trigger tab.
2. Select if Moon data is to be computed and logged.
3. Select if moving data is to be recorded, specifically records unaveraged values and Fresh/Stale results.
4. Select a limit to the number of records. A value of zero is default and means there is no limit. Any other value 1-1000 means that UDM will stop recording after that many records have been taken.
5. Press the “Record” button. The records are stored in a logfile whose location is shown in the “Logfile name” area. A new logfile is automatically created at the beginning of each day (at local time 0:00).
6. Press the “Stop” button when you want to stop the recording process.
7. Log files can be accessed by the “File : Open” menu selection or by pressing the “folder” button shown in the “Log Continuously” screen.
8. Press “Close” when done with the continuous logging feature.

Threshold to record A threshold for recording readings can be set before starting recording. Any reading greater or equal to this threshold value will be recorded in the log file.

![Threshold](image1.png)

Figure 7.25: Log Continuously Threshold

A threshold of 0 will allow all readings to be recorded.
The threshold indicator will turn green if the threshold of the triggered reading is met (recording) and red if the triggered reading is below the threshold (no recording).
The threshold value is saved in the registry configuration file when it is changed. Changes can only be made while not recording.
An override from the command line options (-LC,TH,x) can be made. The override will only take effect for the current session and will not alter the saved configuration.

Pre-reading audio alert In cases where you want to be alerted that a reading will be taken, for example, when manually pointing the meter, the Pre-reading audio alert (Fig. 7.26) can be enabled to play an audio file two seconds before the record is logged. The Test button plays this file for test purposes. The audio file is named `prereading.wav` and is located in the Data Directory (which can be identified from the main page View→Directories).

![Pre-reading audio alert](image2.png)

Figure 7.26: Log Continuously Pre-audio alert

Alarm for darkness When the darkness is over the threshold amount, an audio file can be enabled to play (Fig. 7.27) . The Test button plays this file for test purposes. The audio file is named `alarmsound.wav` and is located in the the Data Directory (which can be identified from the main page View→Directories).

![Alarm for darkness](image3.png)

Figure 7.27: Log Continuously Alarm for darkness
7.5 Log Continuous

**Transfer**  The .dat file can be sent via FTP or SCP to a server by making settings on the left side of the Transfer tab (shown in Fig. 7.28)

![Figure 7.28: Log Continuously Transfer tab](image)

SCP transfers require that the `scp` command exists externally from UDM. For Linux and Mac, the `scp` command is `scp` and can be proven to exist with the `which scp` command. In Windows, you may have to install a program called `pscp` and rename it to `scp`.

**Annotation settings**  While the “Log Continuous” mode is recording data, annotations can be made to the log file records with hotkeys. The Annotation tab allows the definition of hotkeys and their associated annotation text that will appear at the end of an annotated record.

![Figure 7.29: Log Continuously Annotation tab](image)

**Persistent annotation**  The “Persistent” mode makes the annotated text persistently appear at the end of each logged record after the first time the hotkey is pressed.

Without “Persistent” checked, annotation text is only appended to a record when the hotkey is pressed, and other records have no annotation text.

**Synchronized annotation**  The “Synchronized” mode postpones annotation requests until the next scheduled record so that the annotated text is synchronized with scheduled triggered recordings.

Without “Synchronized” checked, the hotkey will immediately trigger a record log, and the associated annotation text will be appended to that triggered record.
**GPS** UDM will read the data produced from an externally connected USB or serial GPS receiver like the GlobalSat BU-353 GPS. Also the Bluetooth GPS Dual XGPS160 has been tested on a Mac.

The following GPS units have been tested with the latest UDM software:

<table>
<thead>
<tr>
<th>GPS</th>
<th>Connection</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlobalSat BU-353</td>
<td>USB</td>
<td>4800 baud</td>
</tr>
<tr>
<td>GlobalSat BU-353 S4 (5Hz)</td>
<td>USB</td>
<td>115200 baud</td>
</tr>
<tr>
<td>Dual XGPS160</td>
<td>Bluetooth</td>
<td>See GPS owners manual</td>
</tr>
</tbody>
</table>

Enter the communications port name (see below) into the Port field, the baud rate into the baud field, then enable the GPS. Once enabled, UDM continuously scans the GPS port for three NMEA words.

**GPS on Windows 10** To get the Communications Port for a USB connected GPS to a Windows 10 computer:

- Click Start → Settings → Devices → Connected-devices
- The GPS should show up there as "Prolific USB-to-Serial Comm Port (COMx)". note which Comm port is listed, one example is COM6 GlobalSat BU-353 S4 (5Hz)
- Make sure that no other programs are accessing the GPS.
- Start up UDM, make sure you meter is selected
- Select Log Continuous → GPS-tab
- Enter the Comm Port into the Port: field, in my case I just typed in COM6
- Enter the baud rate for the GPS into the Baud: field, in my case I just typed in 115200

**GPS on Mac** To get the Communications Port for a USB connected GPS to a Mac computer:

- Follow the instructions for driver installation on the CD provided with the GPS
- Connect the GPS
- Open a terminal window
- Type in: `ls -altr /dev/*` to look for the most recently created file that looks something like `cu.usbserial`
- The newly connected GPS is located at something like `/dev/cu.usbserial`
- Make sure that no other programs are accessing the GPS.
- In UDM → Log-continuous → GPS → Port:, type in that filename. An example would be: `/dev/cu.usbserial`
- Enter the baud rate for the GPS into the Baud: field, in my case I just typed in 115200
**GPS status**  Upon successful parsing of the GPS data, UDM illuminates (with bright green) the associated indicators (GPRMC, GPGGA, GPGSV). If too much time passes, the indicators fade to black.

The signal strength group shows the signal to noise ratio (SNR) for all visible satellites. The satellite number is displayed below each signal strength meter.

The location, speed, time, and status information is displayed as it is received.

If the GPS is enabled before logging, then the logfile is forced to "MOVING" platform mode, and five fields (latitude, longitude, elevation, speed, number of satellites in view) are appended to each record.

**GoTo**  A GoTo pointing device accessory can be controlled by UDM for the purpose of pointing the meter to various parts of the sky and automatically gathering a reading at each position.

The following GoTo devices are currently supported:

- SynScan V4
- iOptron 8408

The connection of the GoTo device is made to the serial port. Note; some USB to RS232 serial adapters do not act properly with UDM. Usually an FTDI addapter should work well.

Select the machine type, port, and baud rate. Ensure that the connected device is actually available on the port you select. In Windows, you can use the Device manager, In Mac and Linux, you can type `dmesg` on the command line in a terminal window to see the latest USB device attached.

A script file containing the positions is located in the “Data Directory” which is identified by:

View→Directories→Data_Directory.

On a Mac, you can use Finder to go to “Applications”, then right click on “udm” or “udm.app” then select “Show contents”. Then you can navigate to Contents→Resources to see the location of the *.goto file(s).

The format of the GoTo script file is a semicolon-separated file with an extension of “.goto”. Comment lines are preceded by the pound symbol (#). The second line defines the field format (Zenith;Azimuth). The remaining lines define the points to move to. An example is:

```
# Default
# Zenith;Azimuth
0;0
15;0
15;60
15;120
```

Control of the positioning is done from the trigger page. The “Goto accessory” and “Freshness” check boxes must be set. Pressing the "Record" button will start the pointing sequence.
7.6 Calibration tab

The Calibration tab is used to show and set the calibration data for the selected SQM device.

![Figure 7.31: Calibration tab (initial)](image)

Press the “Get Calibration Info” button so that the updated calibration data is brought in from the SQM on to the Actual values boxes as shown below.

![Figure 7.32: Calibration tab (populated)](image)

Use the following steps to change the calibration values:

1. Enter the new calibration data on the left side entry box (Desired values column).
2. Press the associated “Set” button.
3. The value is sent to the SQM, and then confirmed in the right side box (Actual values column).

Note that temperatures set in to the SQM use their own resolution and may not be reflected as the same value entered. For example, 24.7°C might read back as 24.8 °C.
7.7 Report Interval tab

The original factory calibration values were provided on a paper with the shipped unit. If you have lost this information, please contact Unihedron to have the information emailed.

7.7 Report Interval tab

The Report Interval tab is used to show and set the report interval information for the selected SQM. Report interval settings are used to control the SQM to send readings out at a regular rate (in seconds) and only if darker than a specified threshold value. See section 8.6 on page 61 for more information about “Interval reporting”.

Figure 7.33: Report interval tab

Use the “R” button to temporarily set the value in to RAM for experimentation. The new value will be used instantly. The RAM value is set to the EEPROM value on power-up.

Use the “E/R” button to set the value in to EEPROM and RAM. The new value will be used instantly and also after power up.

Report interval is measured in seconds (i.e. 300 = 5 minutes).

Report threshold is measured in Magnitudes per square arcsecond (mpsas), a larger positive value is darker.

7.7.1 Continuous reports

The Continuous reports section enables special features related to reporting through an optionally installed I2C interface except for the Ideal crossover function selection.

- Reporting enabled: The readings are sent to the I2C adapter as they are computed.
- Reporting compressed: High speed reporting is sent out in a compressed format.
- Report un-averaged: Send only the unaveraged readings to the I2C device.
- LED blink accessory: Enables the LED on the DL models to blink each time a reading is gathered.
- Ideal crossover firmware: See Theory of operation section 3.1 for full details.

7.8 Firmware tab

In a case where new firmware is supplied by Unihedron to correct bugs or add features, use this tab to select and load firmware in to the SQM-LU.
All available versions of firmware are shipped with the UDM software package in case you want to revert to an earlier firmware version for testing purposes. New firmware versions are announced on the Unihedron forum.

![Firmware tab](image)

**Figure 7.34: Firmware tab**

Follow these steps to load new firmware:

1. Press the “Select Firmware” button to choose the firmware file to load in to the SQM as shown in Figure 7.35:

![Firmware selection](image)

**Figure 7.35: Firmware selection**

2. Select the desired firmware file then press “Open”.
3. The “Load firmware” button will be enabled and you can press it now to start loading the firmware in to the SQM-LU. The status bar will indicate successful completion when the firmware has been completely loaded.

### 7.9 Configuration tab

The “Configuration tab” shows the factory-set calibration values. Calibration is performed at the Unihedron factory. A new calibration using a calibrated light source and darkroom can be performed by following the instructions on the right side of the screen. The calibration report can be logged to a data file and also printed out from this screen.
Warning confirmations as shown in Figure 7.37 and Figure 7.38 are shown when trying to calibrate the unit yourself:

Figure 7.37: Light calibration confirmation

Figure 7.38: Dark calibration confirmation

### 7.9.1 Sensor arrangement

For documentation purposes, the SQM-LU can store information on the sensor arrangement (starting at firmware feature 35 and above). The type of Lensholder, Lens, and Filter can be defined.

Figure 7.39: Sensor arrangement
7 Unihedron Device Manager

7.9.2 Vector datalogger

The SQM-LU can be setup for an all-sky survey of brightness data points. Refer to Figure 7.40 for key points.

![Datalogging page for vector model](image)

Figure 7.40: Datalogging page for vector model

7.9.3 Contour plot

Follow these steps to see a contour plot of the retrieved data:

- Select the “Tools - DL Retrieve” menu item or the “Data Logging” tab then the “Retrieve All” button.

- Select the “Plot” tab.

- Click the “Show data” button, and select the previously retrieved log file.

- The contour plot will appear after all the points have been read in and processed which could take a long time depending on the number of recorded points.

An example of the contour plot is shown in Figure 7.41.
7.9.4 Minimum .dat requirements

The Contour plot reads records from a .dat file created by retrieving data from the SQM-LU. You can use other methods to generate the Altitude and Azimuth field and make up a .dat file yourself. The minimum requirements for the .dat file to be read by the contour plotting function are:

- One comment line describing the field of UTC Date & Time, Altitude, Azimuth.
- One line defining the ending of the header.
- Following lines of data

Here is an example:

```
# UTC Date & Time, MSAS, Altitude, Azimuth
# END OF HEADER
2018-05-15T06:05:24.057;21.85;0;0
2018-05-15T06:05:34.040;21.86;20;0
```

7.10 Simulation tab

The “Simulation” tab is enabled from the View menu.
The “Simulation” tab allows the simulation of raw light sensor values for experimentation purposes. The “Start” button initiates feeding the range of values to the internal formulas of the SQM-LU and results are displayed on this tab. Raw temperature conversions are detail in Eq: 8.1 and 8.2. The simulation will stop once all the steps are complete or when the “Stop” button is pressed.

When using the Simulation mode of the SQM-LU, make sure that nothing else interrupts the sequence of readings such as external programs reading from the SQM-LU, or settings of Interval reporting inside the SQM-LU.

### 7.10.1 Simulation from file

The “From file” button sends csv data from `simin.csv` (in the log file directory) to the SQM-LU in simulation mode and puts the output into `simout.csv`. The format of the csv is shown in Table 7.2:

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3000</td>
<td>Period in counts.</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td>Frequency in Hz.</td>
</tr>
<tr>
<td>3</td>
<td>20.3</td>
<td>Temperature in °C.</td>
</tr>
</tbody>
</table>

Listing 7.1: simin.csv example

```
0,568380,24.8
72970,6,13.2
```

The resultant output records will be shown on the screen and saved in `simout.csv` (in the log file directory) in the form of simulated result shown in section 8.7 as in the example shown in Listing 7.2:

Listing 7.2: simout.csv example

```
# Simulation from file.
# UDM version: 1.0.0.43
# Unit information cx: 1,00000004,00000003,00000032,000000704
# Calibration cx: c,00000019.80m,0000107.511s,028.3C,00000008.71m,029.3C
S,0000000000c,000568380f,0000000232r,00.00m,000568380Hz,0000000000c,0000000000c,028.3C
S,0000072970c,0000000006f,0000000196r,17.79m,00000000006Hz,0000072970c,0000000.158s,013.2C
```
7.11 Accessory options

Some meters can be equipped/retro-fitted with optional accessories if they include firmware feature version \( \geq 40 \).
See section 8.4 for details on the accessory commands.
The accessories tab (shown in 7.43) is available when selecting a device that has the appropriate firmware:

![Figure 7.43: Accessories tab](image)

7.11.1 Humidity accessory

There are currently two types of I\( ^2 \)C humidity sensors that have been tested; HIH8120, and HYT939. The selection can be made with the drop down combo-box on this tab.

Enabling this sensor allows the SQM-LU to poll the sensor once per second to gather a reading which can be requested later with the A1x command.

The refresh button requests the most recent value that the SQM-LU has collected.
The Status field shows the status of the humidity sensor which is updated after the refresh button is pressed. The status is ‘N/C’ when the sensor is not connected.

7.11.2 Display accessory

A 4-digit 7-segment I\( ^2 \)C display can be attached to the SQM-LU. Currently only the Sparkfun COM-11441 has ben tested.

This display shows the brightness reading in mpsas.
The brightness of the display can be fixed at a level between 0-7 (dimmest to brightest), or can be automatically dimmed in bright conditions (depending on the mpsas reading).
The display can be either updated periodically (1Hz) or whenever a reading request is made.

7.11.3 LED accessory

The LED indicator accessory is mainly used for troubleshooting to identify either when readings are created or requested.
The LED blinks for 1/60th of a second.
The LED can blink either when the SQM-LU creates a reading, or when a reading is requested (using the rx command).

7.11.4 Relay accessory

The Relay accessory is mainly used for dew heater control. A 3.3V activated solid state relay can be connected directly to pin 23 of the microcontroller (25mA drive maximum).

When in Manual mode, the relay can be turned on or off.
When in Automatic mode, the relay is turned on when the mpsas reading is above the threshold and off when the mpsas reading is below the threshold.
Pressing the On/Off buttons while the realy is in automatic mode will switch it to manual mode.
7.12 Command line parameters

UDM can be started from the command line. Other stored parameters (like timezone) will be recalled automatically. Here is the summary of options:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-LCMS,x</td>
<td>Every x seconds</td>
</tr>
<tr>
<td>-LCMM,x</td>
<td>Every x minutes</td>
</tr>
<tr>
<td>-LCM,1</td>
<td>Every 1 minute on the minute</td>
</tr>
<tr>
<td>-LCM,5</td>
<td>Every 5 minutes on the 1/12th hour</td>
</tr>
<tr>
<td>-LCM,10</td>
<td>Every 10 minutes on the 1/6th hour</td>
</tr>
<tr>
<td>-LCM,15</td>
<td>Every 15 minutes on the 1/4 hour</td>
</tr>
<tr>
<td>-LCM,30</td>
<td>Every 30 minutes on the 1/2 hour</td>
</tr>
<tr>
<td>-LCM,60</td>
<td>Every hour on the hour</td>
</tr>
<tr>
<td>-LCR</td>
<td>Start recording right away</td>
</tr>
<tr>
<td>-LCTH,x</td>
<td>Threshold setting. Readings equal to or greater than x (in mpsas) get recorded. If x=0 then all readings are get recorded.</td>
</tr>
<tr>
<td>-LCMIN</td>
<td>Minimize Application after Log continuous window starts up</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-SEI,x</td>
<td>Select Ethernet device where x = IP address</td>
</tr>
<tr>
<td>-SEM,x</td>
<td>Select Ethernet device where x = MAC address</td>
</tr>
<tr>
<td>-SUC,x</td>
<td>Select USB device where x = communication portname i.e. /tty/USB0</td>
</tr>
<tr>
<td>-SUI,x</td>
<td>Select USB device where x = ID number ex FTD12345</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-N</td>
<td>Do not search for devices at startup. This cuts down startup time, the user must press the Find button to find devices.</td>
</tr>
<tr>
<td>-P</td>
<td>Display plotter window.</td>
</tr>
</tbody>
</table>
8 Commands and responses

The SQM-LU accepts a sequence of characters as a command, then executes those commands and usually provides a response of a sequence of characters. The following details are useful when programming your own interface to send data to and receive data from the SQM-LU.

8.1 Commands

Commands consist of a string of characters. The first character is the command type. The following is a list of the “Standard” commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rx</td>
<td>Reading request.</td>
</tr>
<tr>
<td>cx</td>
<td>Calibration information request.</td>
</tr>
<tr>
<td>ix</td>
<td>Unit information request (note lower case “i”).</td>
</tr>
<tr>
<td>zcalAx</td>
<td>Arm Light Calibration command.</td>
</tr>
<tr>
<td>zcalBx</td>
<td>Arm Dark Calibration command.</td>
</tr>
<tr>
<td>zcalDx</td>
<td>Disarm Calibration command.</td>
</tr>
<tr>
<td>zcal5</td>
<td>Manually Set Light Calibration Offset.</td>
</tr>
<tr>
<td>zcal6</td>
<td>Manually Set Light Calibration Temperature.</td>
</tr>
<tr>
<td>zcal7</td>
<td>Manually Set Dark Calibration Time Period.</td>
</tr>
<tr>
<td>zcal8</td>
<td>Manually Set Dark Calibration Temperature.</td>
</tr>
<tr>
<td>0x19</td>
<td>Reset micro-controller. Hexadecimal value 19. See the “Firmware Upgrade” chapter on page 68 for more details.</td>
</tr>
<tr>
<td>:</td>
<td>Intel Hex firmware upgrade initiation. See the “Firmware Upgrade” chapter on page 68 for more details.</td>
</tr>
<tr>
<td>P...x</td>
<td>Set period (in seconds) for interval reporting to EEPROM and RAM for booting and immediate use. Firmware feature=13.</td>
</tr>
<tr>
<td>p...x</td>
<td>Set period (in seconds) for interval reporting to RAM for immediate use. Firmware feature=13.</td>
</tr>
<tr>
<td>T...x</td>
<td>Set threshold (in $\frac{\text{mag}}{\text{arcsec}}$) for interval reporting only to EEPROM and RAM for booting and immediate use. Firmware feature≥13.</td>
</tr>
<tr>
<td>t...x</td>
<td>Set threshold (in $\frac{\text{mag}}{\text{arcsec}}$) for interval reporting only to RAM for immediate use. Firmware feature≥13.</td>
</tr>
<tr>
<td>SX</td>
<td>Request reading of internal variables.</td>
</tr>
<tr>
<td>S...x</td>
<td>Simulate internal calculations.</td>
</tr>
</tbody>
</table>
8 Commands and responses

8.2 Response details

8.2.1 Reading request

The “Reading” request “rx” or “Rx” commands the SQM-LU to provide the current darkness value as well as all variables used to generate that result.

Readings produced by this request are averaged internally by using the last 8 readings and shifting those values through an 8 cell buffer then summing and dividing by 8. Use the “ux” command to get the un-averaged and most recent value. Averaging is only performed on period-mode readings (when the light sensor frequency is below 128Hz). Frequency mode readings (above 128Hz) are automatically averaged because the reading is taken from a one second sampling of pulses.

The format of the response is shown in table 8.2:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>r</td>
<td>Indicates that a reading is being returned.</td>
</tr>
<tr>
<td>2-8</td>
<td>.06.70m</td>
<td>Reading in $\frac{mag}{arcsec^2}$. Leading space for positive value. Leading negative sign (-) for negative value. A reading of 0.00m means that the light at the sensor has reached the upper brightness limit of the unit.</td>
</tr>
<tr>
<td>10-21</td>
<td>0000022921Hz</td>
<td>Frequency of sensor in Hz.</td>
</tr>
<tr>
<td>23-33</td>
<td>0000000020c</td>
<td>Period of sensor in counts, counts occur at a rate of 460.8 kHz (14.7456MHz/32).</td>
</tr>
<tr>
<td>35-46</td>
<td>0000000.000s</td>
<td>Period of sensor in seconds with millisecond resolution.</td>
</tr>
<tr>
<td>48-54</td>
<td>.039.4C</td>
<td>Temperature measured at light sensor in degrees C. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>55-56</td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
<td></td>
</tr>
</tbody>
</table>

An example of the response is:

r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C
0123456789 123456789 123456789 123456789 123456789 123456

Future versions of this reading string will only modify reported values beyond position 54. Characters 0 to 54 may be considered stable.

A special case “Rx” command returns the serial number in the same format as the interval report does. See page 61 “Setting Interval reporting parameters” for report details.

8.2.2 Unaveraged reading request

The “unaveraged reading” request “ux” commands the meter to provide the current darkness value as well as all variables used to generate that result. This readings is not averaged out like the “rx” command.

The format of the response is shown in table 8.3:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>u</td>
<td>Indicates that a reading is being returned.</td>
</tr>
</tbody>
</table>

Table continued on next page...
Table 8.3 – continued from previous page

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-8</td>
<td>.06.70m</td>
<td>Reading in $\deg,\text{arcsec}$. Leading space for positive value. Leading negative sign (-) for negative value. A reading of 0.00m means that the light at the sensor has reached the upper brightness limit of the unit.</td>
</tr>
<tr>
<td>10-21</td>
<td>0000022921Hz</td>
<td>Frequency of sensor in Hz.</td>
</tr>
<tr>
<td>23-33</td>
<td>0000000020c</td>
<td>Period of sensor in counts, counts occur at a rate of 460.8 kHz (14.7456MHz/32).</td>
</tr>
<tr>
<td>35-46</td>
<td>0000000.000s</td>
<td>Period of sensor in seconds with millisecond resolution.</td>
</tr>
<tr>
<td>48-54</td>
<td>.039.4C</td>
<td>Temperature measured at light sensor in degrees C. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>55-56</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:

```
u, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C
```
0123456789 123456789 123456789 123456789 123456789 123456

Future versions of this reading string will only modify reported values beyond position 54. Characters 0 to 54 may be considered stable.

### 8.2.3 Unit information

Unit information command “ix” provides details about the software in the micro-controller. The format of the response is:

Table 8.4: Unit information request response

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>i</td>
<td>Indicates that the unit information response is being returned.</td>
</tr>
<tr>
<td>2-9</td>
<td>00000002</td>
<td><strong>Protocol number</strong> (8 digits). This will always be the first 8 characters (after the “i,” response). This value indicates the revision number of the data protocol to/from the SQM-LU. The protocol version is independent of the feature version.</td>
</tr>
<tr>
<td>11-18</td>
<td>00000003</td>
<td><strong>Model number</strong> (8 digits). The model value identifies the specific hardware model that the firmware is tailored for.</td>
</tr>
<tr>
<td>20-27</td>
<td>00000001</td>
<td><strong>Feature number</strong> (8 digits). The feature value identifies software features. This number is independent of the data protocol.</td>
</tr>
<tr>
<td>29-36</td>
<td>00000413</td>
<td><strong>Serial number</strong> (8 digits). Each unit has its own unique serial number.</td>
</tr>
<tr>
<td>37-38</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:

```
i,00000002,00000003,00000001,00000413
```
0123456789 123456789 123456789 123456789 123456789

Unihedron SQM-LU Operator's Manual - 20181226
8 Commands and responses

8.3 Calibration commands

8.3.1 Calibration information request

The calibration information request "cx" returns all data about the specific light sensor in the unit required to calculate a reading.

The format of the response is shown in table 8.5:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>c</td>
<td>Indicates that the calibration information is being returned.</td>
</tr>
<tr>
<td>2-13</td>
<td>00000017.60m</td>
<td>Light calibration offset in $\text{mag arcsec}$.</td>
</tr>
<tr>
<td>15-26</td>
<td>000000.000s</td>
<td>Dark calibration time period in seconds with millisecond resolution.</td>
</tr>
<tr>
<td>28-34</td>
<td>.039.4C</td>
<td>Temperature in degrees C measured during light calibration. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>36-47</td>
<td>00000008.71m</td>
<td>Offset of light sensor in $\text{mag arcsec}$ based on manufacturing reference. The factory calibration light source is equivalent to 8.71 $\text{mag arcsec}$, and when the &quot;Light calibration&quot; button is pressed in UDM, the meter creates the light calibration offset value (17.60 in this case) so that the meter reads 8.71 also.</td>
</tr>
<tr>
<td>49-55</td>
<td>.039.4C</td>
<td>Temperature in degrees C measured during dark calibration. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
</tbody>
</table>

An example of the response is:

c,00000017.60m,000000.000s, 039.4C,00000008.71m, 039.4C
0123456789 123456789 123456789 123456789 123456789 1234567

8.3.2 Light calibration command

Calibration of the SQM-LU is done at the factory in a controlled light and temperature environment.

Executing the Light calibration command "zcalAx" arms the light calibration mode.

A calibrated light source of approximately 13.5fc is supplied to the sensor.

The format of the response is shown in table 8.6:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Indicates that a “Calibration” response is being returned.</td>
</tr>
<tr>
<td>1</td>
<td>A</td>
<td>Indicates Light Calibration mode.</td>
</tr>
<tr>
<td>2</td>
<td>a</td>
<td>Indicates that the calibration is armed.</td>
</tr>
<tr>
<td>3</td>
<td>L</td>
<td>L = Locked; Wait for unlock before calibrating after Arm command, firmware upgrades are disabled. U = Unlocked; Calibrate immediately after Arm command, Enable firmware upgrade.</td>
</tr>
</tbody>
</table>

Table continued on next page ...
An example of the response is:

\[ z\text{AaL} \]

\[ 012345 \]

### 8.3.3 Dark calibration command

Dark Calibration is done at the factory along with Light calibration and calibration temperature recording.

Executing the dark calibration command “`zcalBx`” arms the dark calibration mode.

Dark calibration is performed in a completely dark environment. Check a reading to ensure that the period is correct after entering the dark environment, it could take a few minutes to collect an accurate dark period. A dark period of only a few seconds is too small.

The format of the response is shown in Table 8.7:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>1</td>
<td>B</td>
<td>Dark Calibration.</td>
</tr>
<tr>
<td>2</td>
<td>a</td>
<td>Armed.</td>
</tr>
<tr>
<td>3</td>
<td>L</td>
<td>L = Locked; Wait for unlock before calibrating after Arm command, firmware upgrades are disabled. U = Unlocked; Calibrate immediately after Arm command, Enable firmware upgrade.</td>
</tr>
<tr>
<td>4-5</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:

\[ z\text{BaL} \]

\[ 012345 \]

### 8.3.4 Disarm calibration command

The Disarm calibration command “`zcalDx`” disarms calibration modes from being triggered by the unlock mode.

The format of the response is shown in Table 8.8:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>1</td>
<td>x</td>
<td>Indicates “All” calibration modes.</td>
</tr>
<tr>
<td>2</td>
<td>d</td>
<td>Disarmed.</td>
</tr>
</tbody>
</table>

Table continued on next page ...
Table 8.8 – continued from previous page

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>L</td>
<td>L = Locked; Wait for unlock before calibrating after Arm command, firmware upgrades are disabled. U = Unlocked; Calibrate immediately after Arm command, Enable firmware upgrade.</td>
</tr>
<tr>
<td>4-5</td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
<td></td>
</tr>
</tbody>
</table>

An example of the response is:

```
zxdL
012345
```

8.3.5 Manually set light calibration offset

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else, this command allows a new calibration value to be placed into the meter.

Executing the command “zcal5########.##x” manually sets the light calibration offset to the value specified in “########.##”. The units are \textit{magnitudes arcsecond}.

The format of the response is shown in table: 8.9:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>Manual Set Light Calibration Offset</td>
</tr>
<tr>
<td>4-15</td>
<td>00000017.60m</td>
<td>Value that was set into EEPROM</td>
</tr>
<tr>
<td>16-17</td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
<td></td>
</tr>
</tbody>
</table>

An example of the response is:

```
z,5,00000017.60m
0123456789 1234567
```

8.3.6 Manually set light calibration temperature

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else, this command allows a new calibration value to be placed into the meter.

The “Light calibration temperature” is the temperature of the meter when the meter was calibrated for its “Light calibration offset”.

Executing the command “zcal6########.##x” manually sets the light calibration temperature to the value specified in “########.##”. The units are °C.

Note: The meter records the temperature in a raw value with different resolution, so the reply back may not be exactly the same as the value sent.

The format of the response is shown in table: 8.10:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
</tbody>
</table>

Table continued on next page ...
8.3.7 Manually set dark calibration time period

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else, this command allows a new calibration value to be placed into the meter.

The “Dark calibration time period” is the amount of time that has elapsed for the light sensor to make one cycle while in complete darkness. The meter sets a time limit of 300 seconds on this value.

Executing the command “zcal7###########.###x” manually sets the light calibration offset to the value specified in “###########.###”. The units are in seconds.

The format of the response is shown in table: 8.11:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>Manual Set Dark Calibration time period.</td>
</tr>
<tr>
<td>4-15</td>
<td>00000300.000s</td>
<td>Value that was set into EEPROM</td>
</tr>
<tr>
<td>16-17</td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
<td></td>
</tr>
</tbody>
</table>

An example of the response is:

```
z,7,00000300.00s
0123456789 1234567
```

8.3.8 Manually set dark calibration temperature

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else, this command allows a new calibration value to be placed into the meter.

The “Dark calibration temperature” is the temperature of the meter when the meter was calibrated for its “Dark calibration time period”.

Executing the command “zcal8###########.##x” manually sets the light calibration offset to the value specified in “###########.##”. The units are °C.

Note: The meter records the temperature in a raw value with different resolution, so the reply back may not be exactly the same as the value sent.

The format of the response is shown in table: 8.12:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
</tbody>
</table>

Table continued on next page
Table 8.12 – *continued from previous page*

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>8</td>
<td>Manual Set Dark Calibration temperature.</td>
</tr>
<tr>
<td>4-9</td>
<td>019.0C</td>
<td>Value that was set into EEPROM</td>
</tr>
<tr>
<td>10-11</td>
<td></td>
<td>Carriage return (0xd), Line feed (0xa).</td>
</tr>
</tbody>
</table>

An example of the response is:
```
z,8,019.0C
0123456789 1
```
8.4 Accessories commands

Some I²C accessory devices can be connected to the SQM-LU when using firmware feature version 44 and above. These devices are connected by way of retrofitted wiring inside the unit or a future back panel connector.

All of the SQM-LU accessory commands begin with “A” (upper case).

8.4.1 Humidity / Temperature sensor

Two I²C humidity/temperature sensors models can be connected to the SQM-LU. All commands (seen in table 8.13) to this accessory result in a response (seen in table 8.14).

Table 8.13: Humidity/temperature command summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1Ex</td>
<td>Enable the humidity temperature accessory.</td>
</tr>
<tr>
<td>A1Dx</td>
<td>Disable the humidity temperature accessory.</td>
</tr>
<tr>
<td>A1Mmx</td>
<td>Set the model number (where m=0-7) of the humidity temperature accessory: 0=HIH8120 1=HYT939 (Sold by ControlEverything and others)</td>
</tr>
<tr>
<td>A1x</td>
<td>Report on the humidity temperature status.</td>
</tr>
</tbody>
</table>

Table 8.14: Humidity/temperature response summary

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A,1,</td>
<td>Confirmation of humidity/temperature accessory command.</td>
</tr>
<tr>
<td>1</td>
<td>1,</td>
<td>Accessory 1 (Humidity/temperature sensor).</td>
</tr>
<tr>
<td>2</td>
<td>e,</td>
<td>E for enabled. D for disabled.</td>
</tr>
<tr>
<td>3</td>
<td>m,</td>
<td>Model number (where m=0-7): 0=HIH8120 1=HYT939 (Sold by ControlEverything and others)</td>
</tr>
<tr>
<td>4</td>
<td>s</td>
<td>Status (0-3): 0 = Normal Operation, Valid Data that has not been fetched since the last measurement cycle. 1 = Stale Data: Data that has already been fetched since the last measurement cycle, or data fetched before the first measurement has been completed. 2 = Sensor in Command Mode. 3 = Not used.</td>
</tr>
<tr>
<td>5</td>
<td>nnnnn</td>
<td>Humidity(%RH) = \frac{nnnnn}{214-2} \times 100%. 16383 when no connection.</td>
</tr>
<tr>
<td>6</td>
<td>nnnnn</td>
<td>Temperature(°C) = \frac{nnnnn}{214-2} \times 165 - 40. 16383 when no connection.</td>
</tr>
</tbody>
</table>

An example response to “A1x” is:
A,1,E,1,0,07788,06202
8 Commands and responses

8.4.2 Display accessory

An I²C 4-digit 7-segment display made by Sparkfun (model COM-11441) can be connected. All commands (seen in table 8.15) to this accessory result in a response (seen in table 8.16).

Readings that are too bright for the SQM-LU will show up as ☐ ☐ ☐ ☐. Readings that are too dark for the meter will show up as ☐ ☐ ☐ ☐.

Table 8.15: Display accessory command summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2Ex</td>
<td>Enable the display accessory.</td>
</tr>
<tr>
<td>A2Dx</td>
<td>Disable the display accessory.</td>
</tr>
<tr>
<td>A2Fx</td>
<td>Fixed mode of brightness.</td>
</tr>
<tr>
<td>A2Ax</td>
<td>Auto mode of brightness. Lowers brightness on dark nights. Display at lowest brightness (30%) when greater than 19.00 mpsas. Display at medium brightness (50%) between 17.00 to 19.00 mpsas. Display at full brightness (100%) when less than 17.00 mpsas.</td>
</tr>
<tr>
<td>A2Mnx</td>
<td>Set the model of display (where n = 0-3).</td>
</tr>
<tr>
<td>A2Vnx</td>
<td>Set the fixed mode brightness (where n = 0-7).</td>
</tr>
<tr>
<td>A2Px</td>
<td>Set the updating mode to periodically updating at 1Hz.</td>
</tr>
<tr>
<td>A2Rx</td>
<td>Set the updating mode to updating when reading request is made.</td>
</tr>
<tr>
<td>A2x</td>
<td>Report on the display status.</td>
</tr>
</tbody>
</table>

Table 8.16: Display accessory response summary

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A,</td>
<td>Confirmation of display accessory command.</td>
</tr>
<tr>
<td>1</td>
<td>2,</td>
<td>Accessory 2 (Display).</td>
</tr>
<tr>
<td>2</td>
<td>e,</td>
<td>E for enabled. D for disabled.</td>
</tr>
<tr>
<td>3</td>
<td>m,</td>
<td>Model number (where m = 0-3).</td>
</tr>
<tr>
<td>4</td>
<td>m,</td>
<td>F=Fixed mode. A=Auto mode. See table 8.15 for description.</td>
</tr>
<tr>
<td>5</td>
<td>n,</td>
<td>Fixed brightness level (where n = 0-7).</td>
</tr>
<tr>
<td>6</td>
<td>m</td>
<td>P = periodically updating at 1Hz R = updating when reading request is made. Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example response to “A2x” is:
A, 2, E, 0, F, 2, R
8.4 Accessories commands

8.4.3 LED accessory

For purposes of troubleshooting, an LED with series resistor can be connected to an internal pin of the SQM-LU. All
commands (seen in table 8.17) to this accessory result in a response (seen in table 8.18).

Using the LED to indicate when a reading is being requested is an ideal method to determine if the controlling software
is actually accessing the SQM-LU.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A3Ex</td>
<td>Enable the LED accessory.</td>
</tr>
<tr>
<td>A3Dx</td>
<td>Disable the LED accessory.</td>
</tr>
<tr>
<td>A30x</td>
<td>Mode=Blink at reading creation. In bright sky conditions, readings are created once per second in frequency-mode. In darker sky conditions, the meter goes into period-mode starting at 679Hz and lower, and LED will blink at a variable rate.</td>
</tr>
<tr>
<td>A31x</td>
<td>Mode=Blink at reading request.</td>
</tr>
<tr>
<td>A3x</td>
<td>LED accessory status.</td>
</tr>
</tbody>
</table>

Table 8.17: LED accessory command summary

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A,</td>
<td>Confirmation of display accessory command.</td>
</tr>
<tr>
<td>1</td>
<td>3,</td>
<td>Accessory 3 (LED).</td>
</tr>
<tr>
<td>2</td>
<td>e,</td>
<td>E for enabled. D for disabled.</td>
</tr>
<tr>
<td>3</td>
<td>m,</td>
<td>Model number (where m = 0-7). 0 = LED connected to pin-13 through 1k resistor to ground.</td>
</tr>
<tr>
<td>4</td>
<td>m,</td>
<td>Mode of operation (where m = 0-1): 0 = Blink at reading creation. 1 = Blink at reading request.</td>
</tr>
</tbody>
</table>

An example response to “A2x” is: A,3,E,0,1

Table 8.18: LED accessory response summary
8 Commands and responses

8.4.4 Relay accessory

A Solid State Relay (SSR) accessory may be connected to the SQM-LU for generic use or for purposes of implementing a dew-heater control. All commands (seen in table 8.19) to this accessory result in a response (seen in table 8.20).

Table 8.19: Relay accessory command summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4x</td>
<td>Get status of the relay accessory.</td>
</tr>
<tr>
<td>A40x</td>
<td>Deactivate the relay accessory. Also places the accessory into manual mode.</td>
</tr>
<tr>
<td>A41x</td>
<td>Activate the relay accessory. Also places the accessory into manual mode.</td>
</tr>
<tr>
<td>A4Mnx</td>
<td>Set the mode of operation: 0=Light threshold activated. 1=Dewpoint activation. 2=Heat activated. 3-6=future use. 7=Manual mode where only the A40x and A41x commands affect the relay activation.</td>
</tr>
<tr>
<td>A4Tnnx</td>
<td>Set the darkness threshold for relay activation. Where ( nn ) is the the darkness threshold. Monitoring is performed once per second.</td>
</tr>
</tbody>
</table>

Table 8.20: Relay accessory response summary

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A</td>
<td>Confirmation of display accessory command.</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>Accessory 3 (relay).</td>
</tr>
<tr>
<td>2</td>
<td>s</td>
<td>Status of device: 0 for deactivated relay. 1 for activated relay.</td>
</tr>
<tr>
<td>3</td>
<td>m</td>
<td>Mode of operation (where ( m=0-7 )): 0 = Light mode. 1 = Dewpoint mode. 2 = Heat mode. 7 = Manual mode.</td>
</tr>
<tr>
<td>4</td>
<td>nn</td>
<td>Threshold of darkness (in mpsas) for automatic mode of operation.</td>
</tr>
<tr>
<td>5</td>
<td>ttt</td>
<td>Temperature (°C) used for dewpoint calculation.</td>
</tr>
<tr>
<td>6</td>
<td>hhh</td>
<td>Humidity (%RH) used for dewpoint calculation.</td>
</tr>
<tr>
<td>7</td>
<td>ddd</td>
<td>Dewpoint temperature (°C) used for dewpoint calculation.</td>
</tr>
</tbody>
</table>

Carriage return (0x0d), Line feed (0x0a).

An example response to “A2x” is:

A,4,1,2,15,10,50,40,0
8.5 Continuous reporting commands

The Continuous reporting features are somewhat experimental. A description of each feature follows:

Table 8.21: Summary of standard commands

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting enabled</td>
<td>Send a reading result every time it is available from internal computations. In bright settings, a reading will be made available once per second, around 14mpsas, a reading will be available depending on the sensor response which is between 60+ times per second and 60 seconds in very dark settings.</td>
</tr>
<tr>
<td>Ideal crossover firmware</td>
<td>Changes the crossover of reporting from original (around 15mpsas to 12.32mpsas which results in better resolution across the entire range of possible readings.</td>
</tr>
<tr>
<td>Reporting compressed</td>
<td>Send the above enabled reading out in a compressed format without extra text.</td>
</tr>
<tr>
<td>Report un-averaged</td>
<td>Sends the above reading out from the un-averaged accumulator. Normally the averaged reading is sent.</td>
</tr>
</tbody>
</table>

Table 8.22: Continuous reporting command summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yx</td>
<td>Get status of the continuous reporting features.</td>
</tr>
<tr>
<td>YRx</td>
<td>Enable continuous reporting.</td>
</tr>
<tr>
<td>Yrx</td>
<td>Disable continuous reporting.</td>
</tr>
<tr>
<td>YCx</td>
<td>Enable new crossover firmware code.</td>
</tr>
<tr>
<td>Ycx</td>
<td>Disable new crossover firmware code.</td>
</tr>
<tr>
<td>YPx</td>
<td>Enable continuous reporting compression.</td>
</tr>
<tr>
<td>Ypx</td>
<td>Disable continuous reporting compression.</td>
</tr>
<tr>
<td>YUx</td>
<td>Enable un-averaged continuous reporting.</td>
</tr>
<tr>
<td>Yux</td>
<td>Disable un-averaged continuous reporting.</td>
</tr>
</tbody>
</table>

Table 8.23: Response of all continuous reporting requests

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Y</td>
<td>Confirmation of command.</td>
</tr>
<tr>
<td>1</td>
<td>r</td>
<td>R = Continuous reporting enabled. r = Continuous reporting disabled.</td>
</tr>
<tr>
<td>2</td>
<td>C</td>
<td>C = Ideal crossover firmware code enabled. c = Ideal crossover firmware code disabled.</td>
</tr>
<tr>
<td>3</td>
<td>p</td>
<td>P = Continuous reporting compression enabled. p = Continuous reporting compression disabled.</td>
</tr>
</tbody>
</table>

Table continued on next page ...
### Table 8.23 – continued from previous page

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4      | u             | *U* = Continuous reporting un-averaged readings enabled.  
          |               | *u* = Continuous reporting un-averaged readings disabled. | |
| 5-6    |               | Carriage return (0x0d), Line feed (0x0a). | |

An example response is:

```plaintext
YrCpu
01234
```
8.6 Setting Interval reporting parameters

For firmware feature $\geq 13$, the SQM-LU is capable of sending timed interval reports. Each interval report is the same as the reading request report except that the serial number (feature $\geq 14$) is attached at the end so that numerous reporting SQM-LUs can be distinguished from each other.

The format of the interval report is shown in table 8.24:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>r</td>
<td>Indicates that a reading is being returned.</td>
</tr>
<tr>
<td>2-8</td>
<td>\textunderscore 06\textunderscore .70m</td>
<td>Reading in magnitudes per square arc second. Leading space for positive value. Leading negative sign (-) for negative value. A reading of 0.00m means that the light at the sensor has reached the upper brightness limit of the unit.</td>
</tr>
<tr>
<td>10-21</td>
<td>00000022921Hz</td>
<td>Frequency of sensor in Hz.</td>
</tr>
<tr>
<td>23-33</td>
<td>0000000020c</td>
<td>Period of sensor in counts, counts occur at a rate of 460.8 kHz (14.7456MHz/32).</td>
</tr>
<tr>
<td>35-46</td>
<td>0000000\textunderscore 000s</td>
<td>Period of sensor in seconds with millisecond resolution.</td>
</tr>
<tr>
<td>48-54</td>
<td>\textunderscore 039\textunderscore .4C</td>
<td>Temperature measured at light sensor in degrees C. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>55-63</td>
<td>00000413</td>
<td>Serial number (8 digits). Each unit has its own unique serial number.</td>
</tr>
<tr>
<td>64-65</td>
<td></td>
<td>Carriage return (0xd), Line feed (0xa).</td>
</tr>
</tbody>
</table>

An example is:
\begin{verbatim}
r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C,00000413
0123456789 123456789 123456789 123456789 123456789 123456789 12345
\end{verbatim}

8.6.1 Interval reporting period setting

Executing the command “P####x” (note upper case “P”) sets the period of the timed interval reports to the EEPROM and RAM for booting and immediate use.

Executing the command “p####x” (note lower case “p”) sets the period of the timed interval reports to RAM only for immediate use.

The units are seconds. For example, the command “p0000000360x” sets the reporting time to once every 360 seconds.

8.6.2 Threshold setting for interval reporting

Executing the command “T####.#x” (note upper case “T”) sets the threshold of the timed interval reports to EEPROM and RAM for boot and immediate use.

Executing the command “t####.#x” (note lower case “t”) sets the threshold of the timed interval reports to RAM for immediate use only.

The units are $\text{magnitudes arcsecond}^{-2}$. For example, t00000016.00x limits reporting to values only over 16.00 $\text{magnitudes arcsecond}^{-2}$.
8 Commands and responses

8.6.3 Interval setting response

Either making the request “Ix” (note upper case “I”) or any request to set the interval report setting produces the following response shown in table 8.25:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>I</td>
<td>Interval settings from EEPROM and RAM are being returned.</td>
</tr>
<tr>
<td>2-12</td>
<td>0000000360s</td>
<td>Interval period that was set into EEPROM.</td>
</tr>
<tr>
<td>14-24</td>
<td>0000300360s</td>
<td>Interval period that was set into RAM.</td>
</tr>
<tr>
<td>26-37</td>
<td>0000017.60m</td>
<td>Threshold value that was set into EEPROM.</td>
</tr>
<tr>
<td>39-50</td>
<td>0000017.60m</td>
<td>Threshold value that was set into RAM.</td>
</tr>
<tr>
<td>51-52</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example response is:

$I,0000000360s,0000000360s,0000017.60m,0000017.60m
0123456789 123456789 123456789 123456789 123456789 12$
### 8.7 Simulation commands

The following simulation commands help to determine the results of \( \frac{\text{mag}}{\text{arcsec}^2} \) readings derived from the light and temperature sensors.

When using the Simulation mode of the SQM-LU, make sure that nothing else interrupts the sequence of readings such as external programs reading from the SQM-LU, or settings of Interval reporting inside the SQM-LU.

To read the internal simulation values, issue the “sx” command, the response is shown in table 8.26:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>s</td>
<td>Confirmation of the command.</td>
</tr>
<tr>
<td>1</td>
<td>,</td>
<td>Separation character.</td>
</tr>
<tr>
<td>2-12</td>
<td>0000000360c</td>
<td>Number of counts.</td>
</tr>
<tr>
<td>13</td>
<td>,</td>
<td>Separation character.</td>
</tr>
<tr>
<td>14-24</td>
<td>0000000360f</td>
<td>Frequency in Hz.</td>
</tr>
<tr>
<td>25</td>
<td>,</td>
<td>Separation character.</td>
</tr>
<tr>
<td>26-37</td>
<td>000000244t</td>
<td>Temperature ADC value as seen by the CPU. See Equation 8.1.</td>
</tr>
<tr>
<td>38-39</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example response is:

\[ s,0000000360c,0000000360f,0000000360t \]

To convert raw temperature value to degrees C:

\[
\text{DegC} = \frac{r_{\text{raw}} \times 3.3 - 0.5}{0.01} \tag{8.1}
\]

To convert degrees C value to raw temperature:

\[
r_{\text{raw}} = \frac{(\text{DegC} \times 0.01 + 0.5) \times 1024}{3.3} \tag{8.2}
\]

To set the internal simulation values and read the calculated response, issue the “S...x” command as detailed in Table 8.27. The result of that command is shown in Table 8.28.

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-1</td>
<td>S,</td>
<td>Initiation of Sx command.</td>
</tr>
<tr>
<td>2-11</td>
<td>0000000360</td>
<td>Simulated counts.</td>
</tr>
<tr>
<td>12</td>
<td>,</td>
<td>Separation character (can be anything except x).</td>
</tr>
<tr>
<td>13-22</td>
<td>0000000360</td>
<td>Simulated Frequency in Hz</td>
</tr>
<tr>
<td>23</td>
<td>,</td>
<td>Separation character (can be anything except x).</td>
</tr>
<tr>
<td>24-33</td>
<td>00244</td>
<td>Simulated Temperature ADC value. See Equation 8.1.</td>
</tr>
<tr>
<td>34</td>
<td>x</td>
<td>Terminating character.</td>
</tr>
</tbody>
</table>
An example command is:
\[ S,00000000360,00000000360,00000000360x \]
\[ 0123456789 123456789 123456789 1234 \]

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-1</td>
<td>S,</td>
<td>Confirmation of S...x command.</td>
</tr>
<tr>
<td>2-13</td>
<td>0000094000c,</td>
<td>Simulated counts.</td>
</tr>
<tr>
<td>14-25</td>
<td>0000000000f,</td>
<td>Simulated frequency in Hz.</td>
</tr>
<tr>
<td>26-37</td>
<td>0000000245t,</td>
<td>Simulated temperature ADC value. See Equation 8.1.</td>
</tr>
<tr>
<td>38-39</td>
<td>r,</td>
<td>Beginning of calculated readings.</td>
</tr>
<tr>
<td>40-47</td>
<td>_18.04m,</td>
<td>Calculated ( \frac{\text{mag}}{\text{arcsec}} ).</td>
</tr>
<tr>
<td>48-60</td>
<td>0000000000Hz,</td>
<td>Frequency used for calculation.</td>
</tr>
<tr>
<td>61-72</td>
<td>0000094000c,</td>
<td>Counts used for calculation.</td>
</tr>
<tr>
<td>73-85</td>
<td>0000000.204s,</td>
<td>Calculated period from counts.</td>
</tr>
<tr>
<td>86-92</td>
<td>_029.0C</td>
<td>Temperature used for calculation.</td>
</tr>
<tr>
<td>93-94</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example response is:
\[ S,0000094000c,0000000000f,0000000245t,r,18.04m,0000000000Hz,0000094000c,0000000.204s,029.0C \]
\[ 0123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 1234 \]
9 Installation

9.1 Mechanical installation

Unihedron sells an enclosure that is suitable for mounting either the SQM-LE, SQM-LU, SQM-LR, SQM-LU-DL into. You can read more about it, including plans to build your own at www.unihedron.com/projects/sqmhousing/.

![Image of housing components]

Figure 9.1: Housing

9.1.1 Cover selection

If the unit is to be mounted in exposed location, we recommend the Unihedron plastic weatherproof housing with glass window plate, or an acrylic dome. Acrylic domes will last 2-3 years but eventually weather on the surface. It is not clear that this will affect the reading much. The best test would be to swap a weathered and new one back and forth when changing one out. Presumably the main consideration would be to keep the domes clean every so often and to make sure that the mounting plane is painted black to that it doesn’t reflect light back to the inside of the dome and then back into the meter.

Source of acrylic domes: www.globalplastics.ca/domes.htm

9.1.2 Cover calibration

Since the meter is not weather-proof, it must be protected in some way from the elements. The Unihedron meter housing or a plastic dome is recommended. This will reduce the incoming light (approximately 15-20%).

Because a covering will reduce the incoming light, the resultant reading will be darker (higher \( \text{mag arcsec}^2 \) value). The offset determined by a simple light experiment should be subtracted from the reading.

Apply this subtraction offset as a negative value, i.e. if you measured 16.60 outside the covering, then 16.75 under the dome, then an offset of -0.15 should be applied to all readings.

An example using the UDM software; if your offset is -0.12 and your factory calibrated light calibration offset is 19.92 then you should change the light-calibration-offset on the calibration-tab to 19.80. European users will see and use a comma instead of a decimal point.
9.1.3 Cover maintenance

Keep the covering clean of dust, water, ice, and bird droppings.

Figure 9.2: Example cover calibration
10 Default settings

The SQM-LU contains an FTDI USB interface module.

The FTDI interface has not been altered from its default. There should be no reason to alter the FTDI chip settings. The baud rate is defined by the VCP driver side when a terminal program connects to the SQM-LU.
11 Firmware upgrade

See the UDM “Firmware tab” section on page 40 for instructions on updating the firmware in the SQM-LU.

11.1 Details

The SQM-LU contains a micro-controller that is equipped with a boot-loader mechanism which is enabled for a few seconds after reboot/reset.

Intel hex strings sent to the unit are used to overwrite program memory. The following link contains a thorough description of the Intel Hex format: http://en.wikipedia.org/wiki/.hex

The basic requirements for firmware uploading are:

1. Reset micro-controller by sending the hex character 0x19
2. Within a few seconds, send the first Intel hex record. The colon “:” character indicates the beginning of an Intel Hex record.
3. Wait for a response of “Ok” followed by “CR LF” which indicates that the record was processed properly.
4. Continue sending records and waiting for the acknowledgement.
5. The unit will reset on its own when no more records have been sent for a few seconds.
12 Calibration

The SQM-LU is factory calibrated and a sheet of the calibration values was provided with the unit. Contact Unihedron with your unit’s USB S/N if you need a copy of the original calibration sheet.

Some possible reasons for recalibration are:

1. A new covering/housing is being used besides the small case that the unit was shipped with.
2. A regular maintenance program is desired. There is no great need for this as the SQM-LU has no analog components.
3. Compensation for aged housing, if a plastic dome is used that might have degraded over time.
4. Replaced lens or changed field of view for experimental reasons.

12.1 Recalibration

There is no easy way to perform in-field recalibration. It is recommended to send the unit back to Unihedron for proper calibration. There is a nominal fee for recalibration and shipping. Please contact Unihedron for details.

12.2 Light calibration

The sensor must have a reference point for an amount of light against the signal produced. It is not recommended that this be done after factory calibration and relied upon since an improper setup will result in non-standard results.

A fluorescent light or green LED is used to simulate the spectrum that the meter would see during the night sky. A light meter is used to adjust the light reading to 13.5 fc at the place of the SQM-LU. The light calibration routine inside the SQM-LU expects to see this value.

The light that the SQM-LU and light meter see must be coming from an evenly lit surface.

The “light calibration” command can be sent to the unlocked SQM-LU to set the calibration value.

12.3 Dark calibration

The optical sensor in the SQM-LU produces a reading even when totally dark. This “dark level” reading must be determined so that the meter can compensate for it.

The method of dark calibration is simply to prevent any light from entering the meter then execute a “dark calibration” command to the unit. A darkroom bag is one way to prevent light from entering the unit.

The optical sensor provides timed pulses depending on the amount of light entering. In a dark environment the pulses will be long. The meter has a timeout of 300 seconds, so the dark calibration will take at least 5 minutes (300 seconds) to perform.

Place the unit in a dark environment and monitor the timed readings (rx reading request) until they are consistent, normally the value is in the 80-300 second range, then execute the “dark calibration” command.

12.4 Confirmation

Once the calibration has been done, you should be able to get a light reading from the unit at the calibration light level of the same value as the value printed on your calibration sheet in the “Calibration offset” field, Normally this field has a value of 8.71 mags/arcsec².
## 13 Troubleshooting

### Table 13.1: Reading seem too bright

<table>
<thead>
<tr>
<th>Problem</th>
<th>The meter reads values that are brighter than expected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>The IR filter may have fallen out of the lens.</td>
</tr>
<tr>
<td>Solution</td>
<td>Ensure that there are no extra sources of visible light in the field of view of the meter. Inspect lens for IR filter. You should see a light blue colour inside the lens.</td>
</tr>
</tbody>
</table>

### Table 13.2: Reading is 0.00mpsas

<table>
<thead>
<tr>
<th>Problem</th>
<th>The meter reads values of 0mpsas.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>In bright light over about 6mpsas (even indoors) the meter saturates and will produce a reading of 0mpsas.</td>
</tr>
<tr>
<td>Solution</td>
<td>Test the meter in a darker setting or place a cover over the meter while doing indoor testing. Note: in complete darkness (like a photo-darkroom), the meter may timeout and also produce strange readings.</td>
</tr>
</tbody>
</table>

### Table 13.3: Cannot Find UDM software

<table>
<thead>
<tr>
<th>Problem</th>
<th>Microsoft Edge cannot find UDM software on the CD. Error “Can’t reach this page”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Microsoft Edge has protections in place to hide file lists on remote drives.</td>
</tr>
<tr>
<td>Solution</td>
<td>Use the File Manager to navigate the CD to the Windows directory then install from there. Or, get the latest Windows version of UDM from the Unihedron website: unihedron.com/projects/darksy/cd/Windows/</td>
</tr>
</tbody>
</table>

### Table 13.4: Driver not found

<table>
<thead>
<tr>
<th>Problem</th>
<th>USB driver not found</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Some operating systems may not have the FTDI VCP USB driver installed by default.</td>
</tr>
<tr>
<td>Solution</td>
<td>You can get the most updated driver for your operating system from FTDIchip.com here: <a href="http://ftdichip.com/Drivers/VCP.htm">http://ftdichip.com/Drivers/VCP.htm</a></td>
</tr>
</tbody>
</table>

### Table 13.5: USB device not found, or more than one device on the same COM port

<table>
<thead>
<tr>
<th>Problem</th>
<th>USB device not found, or more than one device on the same COM port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Faulty USB software driver, or faulty USB hardware port on computer</td>
</tr>
</tbody>
</table>

*Table continued on next page ...*
### Table 13.5 – continued from previous page

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Try the meter on another USB port on the computer. Sometimes certain USB ports do not work for various software or hardware reasons.</td>
</tr>
<tr>
<td>• Ensure that the latest FTDI USB VCP driver is installed, you can check the version number from FTDIchip.com here: <a href="http://ftdichip.com/Drivers/VCP.htm">http://ftdichip.com/Drivers/VCP.htm</a></td>
</tr>
<tr>
<td>• Use the UDM software to identify found devices. The SQM-LU device has a serial number prefix of FT...... This may help identify what the other device is.</td>
</tr>
<tr>
<td>• Remove any other USB devices attached to the system to troubleshoot this problem.</td>
</tr>
<tr>
<td>• Try to reassign the SQM-LU to another COM port using the Windows Device Manager. For example, if the SQM-LU is assigned to COM1, then try to assign it to a free COM port number.</td>
</tr>
</tbody>
</table>

### Table 13.6: Recording stops

<table>
<thead>
<tr>
<th>Problem</th>
<th>The meter stops recording while connected to the computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Some computers, especially laptops, have the “USB suspend mode” activated which puts the USB port to sleep when there is not enough activity on the computer.</td>
</tr>
<tr>
<td>Solution</td>
<td>The USB sleep issue can be corrected by ensuring that your power settings do not put the USB ports to sleep when the computer is inactive. This can be true for any operating system. In Windows, the Windows Control panel procedure to disable the USB suspend setting is located here: Start Control Panel Hardware and Sound Power Options Edit Power Plan Settings Put the computer to sleep while plugged in = Never Change advanced power settings USB Settings USB selective suspend setting Plugged in = Disabled OK Save changes</td>
</tr>
</tbody>
</table>

### Table 13.7: Meter cannot be found by PC

<table>
<thead>
<tr>
<th>Problem</th>
<th>Meter cannot be found, or stops working intermittently when connected to computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Faulty FTDI USB module inside meter.</td>
</tr>
</tbody>
</table>

*Table continued on next page*
Table 13.7 – continued from previous page

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is not much that can be done to correct this aside from replacement. However, the following test usually reliably proves the issue. While connected to the computer using UDM, run the unit in “Log continuous” mode at 1 second sampling for at least 1000 samples. If there are any missed readings, the “records missed” counter on the screen will increment and show Red. The test procedure is as follows:</td>
</tr>
<tr>
<td>1. Start UDM and select the device.</td>
</tr>
<tr>
<td>2. Press the “Reading” button to test connectivity.</td>
</tr>
<tr>
<td>3. Press the “Log continuous” button.</td>
</tr>
<tr>
<td>4. Select “Every x seconds”.</td>
</tr>
<tr>
<td>5. Enter 1 into the s box to the right of the selection.</td>
</tr>
<tr>
<td>6. Press “Record”.</td>
</tr>
<tr>
<td>7. Let this run for at least 1000 records and watch that are no “Records missed”.</td>
</tr>
</tbody>
</table>

---

Table 13.8: Meter cannot be found by Windows operating system

| Problem | The windows computer cannot identify the SQM-LU, and re-installing the FTDI device drivers does not help. |
| Cause | The Windows FTDI driver installation may be storing old attempts at installing drivers that should have been cleared out. |
| Solution | The following steps can be used to clean up the FTDI entries in Windows: |
| | 1. Install this FTDI “CDM Uninstaller” utility at: www.ftdichip.com/Support/Utilities/CDMUninstaller_v1.4.zip |
| | 2. The detailed instructions for its operation are here: www.ftdichip.com/Support/Utilities/CDM_Uninstaller_GUI_Readme.html |
| | 3. Here is a quick summary of the instructions: |
| | 4. Start up the CDM uninstaller program |
| | 5. Press - Add |
| | 6. Press - Remove devices |
| | 7. Wait 5 minutes or so until complete |
| | 8. Close |
| | 9. Re-insert SQM-LU device |
| | 10. Wait 5 minutes or so for Windows to install driver and port |
### Table 13.9: Cannot get a reading

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cannot get a reading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Driver is not installed or the SQM-LU is not connected</td>
</tr>
</tbody>
</table>
| Solution| For Windows, check that the unit is registered using the registry editor from the Start menu, select Run, then type in `regedit` and press OK. For Windows XP and Windows 2000, look here for your device: HKEY_LOCAL_MACHINE\SYSTEM\Enum\FTDIBUS\VID_0403+PID_6001+Serial_Number\0000\PortName  
For Windows 98 and Windows ME, look here for your device: HKEY_LOCAL_MACHINE\SYSTEM\Enum\FTDIBUS\VID_0403+PID_6001+Serial_Number\0000\PortName  
The `Serial_Number` is printed on the bottom of the unit. The above will identify which COM port the SQM-LU has been assigned. If the SQM-LU is plugged in, the active COM port will show up in this list: HK_LOCAL_MACHINE\HARDWARE\DEVICEMAP\SERIALCOMM  
For Linux and Mac, use `ls Hal` to determine which device the FTDI driver has attached the SQM-LU to. The CD contains a Perl script `findftdi.pl` to filter out the lshal output. |
## Glossary

Table 14.1: Glossary of terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC</td>
<td>Analog to Digital Converter. A device used to convert an analog signal into a digital value.</td>
</tr>
<tr>
<td>CCD</td>
<td>Charge coupled device is a type of image sensor.</td>
</tr>
<tr>
<td>EEPROM</td>
<td>Electrically Erasable Programmable Read Only Memory is a type of memory that retains its contents after the power has been removed. This type of memory has a limited write/erase cycle as well as a lifetime for data retention. In the SQM-LU, the parameters in the micro-controller can be written 1 million times and last for 100 years.</td>
</tr>
<tr>
<td>Firmware</td>
<td>The program that resides inside the device. In the case of the Unihedron SQM products, it is the software running the device including reading and reporting the light values.</td>
</tr>
<tr>
<td>FITS</td>
<td>Flexible Image Transport System is an open standard defining a digital file format useful for storage, transmission and processing of scientific and other images.</td>
</tr>
<tr>
<td>FTDI</td>
<td>Future Technology Devices International is the manufacturer of the USB module inside the SQM-LU. FTDI also supplies the VCP software driver for the computer operating system so that the SQM-LU can communicate with the computer.</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Positioning System. A GPS receiver may be connected to a computer to allow UDM to integrate the location information into the logged data. See UDM for more details.</td>
</tr>
<tr>
<td>mpsas</td>
<td>Magnitudes per square arcsecond. The unit of measurement reported by the SQM.</td>
</tr>
<tr>
<td>NMEA</td>
<td>National Marine Electronics Association data format that the GPS receiver produces.</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory. Temporary memory that only retains data while power is applied.</td>
</tr>
<tr>
<td>SQM-LU</td>
<td>Sky Quality Meter with Lens and USB connectivity.</td>
</tr>
<tr>
<td>UDM</td>
<td>Unihedron Device Manager is software used to access the SQM series of meters.</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VCP</td>
<td>Virtual COM port (VCP) drivers cause the USB device to appear as an additional COM port available to the PC. Application software can access the USB device in the same way as it would access a standard COM port. The SQM-LU requires the FTDI VCP driver be installed on the computer operating system so that communications can be done with the meter.</td>
</tr>
</tbody>
</table>
15 Bibliography


Company information

| Mailing address | Unihedron  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>4 Lawrence Avenue</td>
</tr>
<tr>
<td></td>
<td>Grimsby, Ontario L3M 2L9</td>
</tr>
<tr>
<td></td>
<td>Canada</td>
</tr>
<tr>
<td>Telephone</td>
<td>(905) 945-1197</td>
</tr>
<tr>
<td>Fax</td>
<td>(905) 945-6770</td>
</tr>
<tr>
<td>Website</td>
<td>unihedron.com</td>
</tr>
</tbody>
</table>